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Warranty, liability and support

Note

We do not accept any liability for the information contained in this document.

Any claims against us - based on whatever legal reason - resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Examples shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). However, claims arising from a breach of a
condition which goes to the root of the contract shall be limited to the foreseeable
damage which is intrinsic to the contract, unless caused by intent or gross
negligence or based on mandatory liability for injury of life, body or health The
above provisions does not imply a change in the burden of proof to your detriment.

Copyright© Copyright-2006 Siemens A&D. It is not permissible to transfer or
copy these Application Examples or excerpts of them without first having
prior authorization from Siemens A&D in writing.

If you have any recommendations relating to this document then please send them
to us at the following e-mail address:

mailto:sdsupport.aud@siemens.com

The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to pro-vide support for typical applications. You are responsible in ensuring that
the de-scribed products are correctly used. These Application Examples do not
relieve you of the responsibility in safely and professionally using, installing,
operating and servicing equipment. When using these Application Examples, you
recognize that Siemens cannot be made liable for any damage/claims beyond
the liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice. If there are any deviations
between the recommendations provided in these Application Examples and
other Siemens publications - e.g. Catalogs - then the contents of the other
documents have priority.
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Introduction

Objective of the application

This application was generated to provide users with a user-friendly way to operate
and visualize the control of an ET200S FC frequency converter using SIMATIC
Manager.

A special program example was generated for this purpose.
This application shows how to use this example.

Core contents of this application
The following core points will be discussed in this application:
e Hardware and software prerequisites to utilize the example
e Installation, integration and adaptation of the program example
e Controlling the ET200S FC from the variable tables of the S7 project

Definition of the scope
This application does not include a description of the
e STARTER commissioning tools
e SIMATIC STEP 7 engineering tools
e der Projektierungssoftware ProTool/Pro CS
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1

Description

These instructions describe the “ET200S FC Shell” software package comprising
the following components:

0 Step 7 Program example
0 2-language HMI TP170B color configuring (German / English)

o Or optionally, a 2-language HMI TP170B monochrome configuring (German /
English).

This program example is based on the partner function block of the FB100

frequency converter (ET200S_FC_DRIV) and provides the following features:

o0 Complete quick commissioning and optimization of one or several ET200S FC
drives from a TP170B panel

0 Operator interface to operate the ET200S FC drive independently from other
parts of your program.

Diagnostic screen to read-out and acknowledge ET200S FC fault messages.
Screen to simply write to and read from the MMC parameter memory.

When an ICU24F (safety ICU) is used, it isn't possible to completely commission
this via the TP170B screen. The reason for this is that it is not permissible to
influence safety parameters using the Step 7 program. The safety parameters still
have to be entered using the “Starter” commissioning tool.
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2 Prerequisites
2.1 Hardware

The following hardware components are required to operate the ET200S FC:

0 SIMATIC S7-300 or SIMATIC S7-400 with integrated Profibus-DP interface.
Alternatively, you can also use an ET200S IM151-7 CPU.

o0 [ET200S system with IM151 interface module and PM-D power module when
using the ICU24 (standard converter) or power module PM-D FX1 or PM-D F
Profisafe when using the ICU24 F (fail-safe converter).

0 One or several ET200S FC frequency converters comprising an ICU24 or
ICU24 F control unit and IPM25 power unit with the appropriate terminal
modules.

0 TP170 B color panel or TP170B monochrome panel

2.2 Software prerequisites
0 STEP 7 from Version 5.2, Servicepack 1 or higher plus Hardware Support

Package (HSP) for the ET200S FC frequency converter. The Hardware Support
Package is directly downloaded into STEP 7 from HW Config. There, the
correct link is already pre-set.

Protool/Pro CS from Version 6.0

When using the “PM-D F PROFIsafe” power module, it is also necessary to
additionally use the “S7 Distributed Safety V5.2” software package.
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3 Installing the program example
3.1 Integrating the program example

Start the SIMATIC Manager.
Set-up a new project using SIMATIC Manager.

Enter a hardware configuration corresponding to the hardware that you are
using. For more detailed information, please refer to the ET200S FC Operating
Instructions in Chapter Connection to SIMATIC S7 > Creating the hardware
configuration in SIMATIC Manager.

De-archive (extract) the FC_SHELL S7 program using File > Retrieve....

In the SIMATIC Manager open the project ET200S_FC_Shell using File >
Open > User projects.

Ls/ SIMATIC Manager

File PLZ View Options “Window Help

D[z 22w %] 5| ¥

Dpen Project

Uszer projects | Liblariesl Sample pmiectsl Multipraiectsl

Mame | Starage path ;l
% BS_2916_171103 [:vAnlagentanlagen StepThkoest
% BS_2918 171103 D:vAnlagentanlagen Step?’\KuesttJ
% ET 2005 FC K.offer D:MAnlagenhdinlagen StepSieme
% ET2005 FC Safety Sage [:vAnlagenhanlagen Step?Sieme
% ET2005 FC Wand D:hAnlagenhdinlagen StephSieme
% ET FC_Safety D:hAnlagenhdinlagen Step?Sieme

D:hAnlagen'dnlagen Step

|Jzer Projects:
Libranes:

Sample Projects:

b ultiprojects: . Browse... |
OF. | Cancel | Help |

o Depending on which one you are using, copy the appropriate HMI panel - the
TP170B monochrome or TP170B color configuring — into your project.
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3.2

‘SIMATIC Manager - [ET2005_FC_Shell -

D:\Anlagen'....\02_Schale ET2005 FC'\Step7\,ET2005_F]

ET200S FC

£ File Edit Insert FLC ¥iew Options ‘Window Help

=5
= L

DIz gelm) 2 [sle [+ =

5| [<NaFiters - 3B =2m| el

I Object name

| Syrnbalic name

| Lazt modified

SIMATIC 300
A TP170E Calar
A TP170E Mono
B2 1PIT)

B2 PROFIBUSH)

| Tupe | Slzal Auithor
SIMATIC 300 Station
SIMATIC OF -~ &RDED
SIMATIC OF - &30 5D
Pl 2984
PROFIELIS 7620

06.05.2005 03:44:09
29.06.20056 11:36:22
29.08.2005 11:21:33
a.05.2005 11:29:4
28.06.2005 11:07:26

o From the Blocks folder, copy all of the blocks into the Blocks folder of your

project.

[

2 SIMATIC Manager - [ET200S_FC_Shell - D:\Anlagen',...\02_Schale ET2005S FC\Step 7 ET200S_F]
% File Edit Insert PLC View Options Window Help

D|=| 27|m| &%) b= S

[« HoFiter > - % 39)E| ==m E”

E\% ET2005_FC_Shel

E-E SIMATIC 300

Function of the individual blocks

- crumis2oP
=z 57-Frogiamm
(B Duelen
RRFe] £ cuisteine

Object name |_Symbolic name | Cieatedin language | Sizein the work me... | Type | Wersion|
0B b ain Program Sweep STL 74 Organization Block o1
i} 0Ba2 140 Point Fault STL 38 Organization Black o1
40+ 0B8E Loss Of Rack Fault STL 38 Organization Black 01
i+ 0B100 Complete Restart STL 42 Organization Black 01
3 FB38 ET2005_FC_DRG STL 188 Function Block 01
3 FBIS ET2005_FC_SHELL STL 5430 Function Block 29
& FE100 ET2005_FC_DRIV STL 1342 Function Block 22
40 DB1 Axis_DB_ET2005_FC_1 DB 236 Datsblock derived fr.. 0.1
£ DB2 Awiz DB_ET2005_FC_2 DB 236 Datablock derived fr.. 0.1
3 DBgA IDB_ET2005_FC DB 288 Instance data block oo
£ ubT Axiz_DB_ET2005_FC STL - Data Type 28
'“E’ ET2005 FC Drive 1 ET2005 FC Drive 1 - Mariable Table o1
g ET200S FC Drive 2 ETZ2005 FC Drive 2 - Wariable T able 01
&3 SFC14 DPRD_DAT STL - Swgtem function 1.0
&3 SFCIS DPWHR_DAT STL - Sustemn funclion 1.0

e OB1 (cyclic program)
Calls the FB98.
Resets the start-up flag M100.0 in the last network.

e OB100 (start-up program)

Sets the start-up flag M100.0.

e FB98 (ET200S_FC_ORG)
Calls the FB99 for each ET200S FC.

After the CPU has restarted, in network 1 the first ET200S FC drive in
the project is selected on the HMI screen.

e FB99 (ET200S_FC_SHELL)

Calls the ET200S FC partner block FB100. All of the functions, that are
activated via the TP170B panel, are programmed in this block

e FB100 (ET200S_FC_DRIV)
ET200S FC partner block.

Standard FB to cyclically transfer the process data between the PLC
and the ET200S FC

e UDT1 (Axis_DB_ET200S_FC)

UDT to generate the Axis_DBs.
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DB1 (Axis_DB_ET200S_FC_1)
Axis_DB for the first ET200S FC.
e DB2 (Axis_DB_ET200S_FC_2)
Axis_DB for the second ET200S FC.
e DB98 (IDB_ET200S_FC)
Multi-instance DB to call the individual ET200S FC drive
e Variable Table — “ET200S FC Drive 1*

The most important control and feedback signals of the first ET200S FC
drive are listed in this variable table.

e Variable Table — “ET200S FC Drive 2“

The most important control and feedback signals of the second ET200S
FC drive are listed in this variable table.

3.3 Adapting the program example to your HW Config

0 Open the HW Config of your program and read-out the starting address of the
configured ICU24. In this example, it is 256 for the first drive and 264 for the
second ET200S FC drive.

LIHVW Conhig - gl U0 (Configurakion) -- L1l

Eﬂ] Station Edit  Imsert PLC  Wiew Options window  Help

D[22 %] S snfsin| [ =] 52| N2

1 PS5 307! - PROFIBUS[T): DP master spstem (1]
2 CPU 31 J M
Xz DE M5

E

o —
1| |
ﬂﬂ (3) IM151-1 Basic

Slat todule ... | Order Murnber | Address [ Address Comrmernt
1 o T eeF LY SBEK1 90 ORE 00

2 ICU24 B51L3244-05400-14450 286,262  |2B6..263

3 ICU24 BSL3244-05400-1440 264,271 264,271

4

0 Open the FB98 and enter the address of the first ET200S FC drive into network
2 (refer below). Do exactly the same with the second ET200S FC by entering
the address in network 3.
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2

ESLAD,/STL/FED - [FB98 - "ET2005_FC_ORG" -- ET2005_FC_Shell' SIMATIC 300,CPU 315-2 DP'../\FB98]
i} File Edt Insert PLC Debug ‘iew Options Window Help

D23~ E] 2| &|s(@] <|o| el [ 2aler| 1<) Dl 2] JH3H-0

|Cont,ent,s 0f: 'Enwironment’\Interface'
E--@ Inter face ;II |NaITE
4 1N x|

Netwwork 2 : ETZ005 FC, lst Drive

Comment -
i3
L ZE6 S <- Moduleadress (ses HII-Config)
T "Axis_DE_ETz003_FC_l1"_ Basic_data Moduleadress
i) "M ldo.ad"
= "Axis_DE_ETz002_FC_l1"_ Basic_data. Startup_flag
Jj/========s===ss=s=so=ss=ss-s=ss=ssso=ss=sss=ss=sss=ssssss=ssssss=ss-ssss=sss=ssss
CALL #insteuerung ETZ003_FC_1
HNr_Axis DE:=1 Sf <= Mumber of Axis-DE, lst ETZ00E FC
Jj/========s===ss=s=so=ss=ss-s=ss=ssso=ss=sss=ss=sss=ssssss=ssssss=ss-ssss=sss=ssss

Netwwork 3 : ETZ005 FC, Znd Drive

Comment :
fi=5
L ZEd Ff 4- Moduleadress (see HO-Config)
T "Axis DE_ETZ002_FC_2"_ Basic_data.Moduleadress
u "M l00.0
= "Axis DE_ETZ00S_FC_Z'"_Basic_data.Startup flag
//===========================================================================
CALL #insteuerung ETz002_FC_Z
Nr_Axis DE:=Z F# - Mumber of Axis-DE, Znd ETZ00S FC
ff===========================================================================

o For all of the other ET200S FC axes configured in your HW configuration,
proceed from network 4 onwards in just the same fashion. Please note that
multi-instances are used in this block. This means that a separate data block is
not required to call the FB99, but a static variable is used (refer to “STAT”, file
type “ET200S_FC_SHELL"). If you have only configured one ET200S FC axis,
then please delete network 3.

o0 Save the FB98.

3.4 Generating the Axis_DBs

You require one Axis_DB for every configured ET200S FC. The complete ET200S
FC drive is controlled using this Axis_DB.

0 Insert a data block in the SIMATIC Manager using the selected block folder
using Insert > S7 Block > Data Block.
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L JSIMATIC Manager - [ET2005_FC_shell -- D% Anlagen'...,02_Schale ET2005 FC'\.Step T4 ET2005_F]

£ File Edit | Insert PLC View Options ‘Window Help

W[~ [ g Faton " < No Filter » -
_|_| i SLIbI'IEt [ _| I -
El--% ET2000 Program ko |name | Syrnbolic hame | Created in languar
SR M ait Program Sweep STL
- = St F
= o - e 5TL
= Ik : 1 Organization Block,
) ack Fault 5TL
2 Function Black,
3 Funiction Restart 5TL
Symnbal Table 4 Data Block FC_ORG STL
Jaca olocE,
Tiesk Litbrary CTETey - FC_SHELL STL
Extermal Source,. . & \-'ariablszable FC_DRI STL
. : , ——JET2005_FC_1 DB
Eazame Ier t t duis_DB_ET2005_FC_2 DB
SEREE IS IDE_ET2005_FC DB
o UDT1 Axiz DB_ET2005_FC STL
WA i ——— - ——————— o

o0 For the type, select DB of type and UDT1. Then assign a unique Symbolic
Name and a Symbol Comment. You can freely select the data block number.
However, in order to keep the program transparent, you should allocate the
data block numbers in increasing order, in the same sequence as the ET200S
FC drives are configured in your drive system.

‘SIMATIE Manager - [ET2005_FC_sShell -- D:' Anlagen’,..."02_Schale ET2005 FC'Step 7',
B Fle Edit Insert FLC View Options Window Help

0| 32)#7| % B2/ dal [o =5 | [« MoFiter> -1%| %8s Bl
E% ET2005_FC_Shel Object name | Symbaolic name | Created in language | Size in the waork mi
E‘" SIMATIC 300 i OB b ain Program Sweep 5TL
= cPU 52 0P
O o zl
. Il
(&) Bue =n General - Part 1 IGeneraI- Part 2| Calls I Attributesl
----- {£H Bausteine —
Mame and type: IDB3 l IDB of bype j IUDT1 j] 3
Symbaolic Mame: IAxis_DB_ET2DEIS_FC_3 1
Symbol Comment: IAxis_DB, 3. ET2005 Fol
Created in Language: De hd
Froject path: I
St locati
ng;?:ct?ca on ID:\AnIagen\AnIagen Step?hSiemenzhSiemens Erlangen ET 200 FChe
Code Interface
D ate created: 23/06/2005 03:02:03 Fid
Last modified: 29/06/2005 03:02:09 Phd 23/06/2005 03:02:09 Pk
Camment: ;I
Cocel | teb |

0 When configuring the additional Axis_DBs for the ET200S FC drives, proceed
in the same way.

0 Re-open the FB98.
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0 For Nr_Axis_DB enter the number of the Axis_DB of the first ET200S FC drive
into network 2 (refer below).

fit3d /
{} File Edit Insert PLC Debug View Options Window Help

Dl(e~(Q] S| & ||| o] vl [ =2aler| 2] Dlm| k2 JE94<

|C0ntents 0f: 'Environment'Interface’
E--@ Interface ;I | |Narrla
R R S

Network 2 : ETZ00% FC, lst Drive

Comment -

ff===========================================================================

L ZE& Ff == Moduleadress (see HW-Config)

T "Axis DE_ETZ00S8 _FC_1".EBasic_data.Moduleadress

u "M loo.at

"Axis DE_ETZO0S_FC_ 1" _Basic_data. Startup_ flag

ff===========================================================================

CALL _ fincteperyng RTEO0S FC 1

[ Nr_Axis_DB:=1 /¢ <- Humber of Axis-DE, lst ET200S FC]

T N e

Network 3 : ETZ00% FC, Ind Drive

Comment -

ff===========================================================================

L Zed Ff == Moduleadress (see HW-Config)

T "Axis DE_ETzZ008 _FC_Z".FBasic_data.Moduleadress

"M loo. ot

= "Axis DE_ETZO0S_FC_Z" _Basic_data Startup flag
ff===========================================================================

CALL ﬁAnst,euerung_ETZDDS_FC_Z

Mr_Axis _DBE:=Z ## <= Mumber of Axis-DE, Znd ETZ00S FC
ff=========================================z==================================

0 Proceed in precisely the same fashion for the additional ET200S FC drives from
network 3 onwards.

0 Save the FB98 and transfer all of the blocks into your control.

3.5 Adapting the HMI configuring

In order to control and visualize the ET200S FC, HMI configurations for a TP170B
monochrome and for a TP170B color panel are also supplied with this program
example.

To adapt to your particular system, please proceed as follows.

0 Open in the SIMATIC Manager the TP170B configuration by double clicking on
it.
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0 Open the properties dialog box of the coupling to the PLC using “Control”,
double clicking on Control_1 and the Parameters... button.

{ " SIMATIC ProTool/Pro CS - [Project - TP170B Color]

File Edit “igw Insert Swskem  Options  Window 7

[DER[Ea Taes| iBR|oo R

” Englisch [U54]

o|fas %

Area Pointers Driver:

=458 TP170B COLOR - TP1706 Calar Mame /| Pratocal | Interface | PLC
ﬁ Screens Steuerung_l  SIMATIC 57 - 300,400 IF1B
----- 9 Messages
----- 5 Recipes
----- m Scheduler
PLC 2| x

-l Tags M|
:_t::zfx Tags Warne: Steuerung 1
""" 3¢ Graphics System Clack: [ 100 Dff-ine: [ Cancel
----- & Text/Graphic Lists HREnEEEE #IESmE ne
----- B Controllers

L [ SIMATIC 57 - 3007400 VED v

0 Now parameterize the connection between the TP170B panel and the PLC
corresponding to your configuration.
An HMI panel should be connected to the PLC preferably via MPI bus. The
communication load between PLC and HMI via Profibus might reduce the
Profibus performance.

SIMATIC 57 - 300,400 ﬂ

Connect OF ta netwark:

— OP Parameters

-- Defing the paramet

MPI[T] = Interface: IIF1 B VI
FROFIEUS(T] Cancel |
Address: |1

Chooge a communication peer/spmbol lisk:

- = Defite the parameters yourzelf - Profile;
[+ -Mat nebwaorked-

Orly Mazter on the Bus: r
Ilse B outing [
r— Metwork Parameters
Llall hd
Baud rate: |18?.5 'I

Mare...

— Peer Parameter
Address:

Expansion Slat:
Rack:

Cyclic Operahior;

a 171 \_

A&D SD

13/31



Copyright © Siemens AG 2010 All rights reserved

SI E M E NS Installing the program example

Description of the “ET200S FC Shell” software package ET200S FC

0 Accept the settings by pressing the OK button and then close the properties
dialog box of the coupling to the PLC.

0 Under Text/Graphic Lists select the Axis_number text list.

{" 'SIMATIC ProTool/Pro CS - [Project - TP170
File Edit View Insert Swstem Options  Window 7

JJDD”H|§|X$@@|J{,E|nm|¥?HJEngnsch[USA] =

JJ’F_?I X | sl

(-8 TP1708 COLCR - TP170B Color Hame 4| Type |
ﬁ creens & Avis_rumber Decimal
""" & Mes.sages & Drive_data_set Decimal
""" = Re:pdesl &PET2005_FC Error Decimal
EI ?C eruler o lRp ] Text List 2=
ags
= ?t. ex T &PET2005_F
_____ TrL;nE:x o &Index_roo TestList |
..... 2¢ Graphics gln:ex_rﬂﬂ Nanme: Tupe
""" (& Text/Graphic Lists Indiex_r00 I!Axis_numher ’_ & Decimal ¢ Binay © Bit lﬂ_ﬂ|
..... Contrallers S 1ndex_roo
[Tl Area Pointers glndex_rﬂg
0100
@p Drive 1
pO300 2 Drive 2
& po33s
& poron
&Epioon
&p1z1s
&p1300
& p1300_1
@plSDD Add Femove |
&ronnz
@Rjaramel Walue: Text
@Status_ﬁac |1— - l— |Drive 1
@Status_loa
@Status_loa
& atatus_loa Reference »» |
@Status_loa
& tatis Mo

|33 Objecti{s) |1 objectis) selected aK I Cancel

=] TP1708 Colorl

Walue | Text

o0 Now edit the symbol list corresponding to your system and the Axis_DB data
blocks you are using. This symbol list is subsequently used to select the
ET200S FC drive to be operated from the TP170B.

o0 Example when editing the symbol list:

- Your system comprises two ET200S FC drives. For the first ET200S FC,
you have programmed DB1 as the Axis_DB and you have programmed
DB2 for the second.

- Remove all entries of the symbol list by repeatedly pressing the Remove
button.

- Enter a1 (DB1) for Value, and under Text, enter the designation of the
first ET200S FC. Then press the Add button.

- Next, enter a 2 (DB2) for Value and under Text enter the designation of
the second ET200S FC. Then press the Add button.

- The symbol list now has two entries — value 1 and value 2 — with the text
symbols that you are assigned.
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o For information purposes, it is not absolutely necessary to start in the symbol
list with the value 1. It is not necessary to consecutively continue with the
symbol list — you can also leave gaps. However please note that you may only
specify ET200S FC Axis_DBs that are also available (programmed) in the PLC.

0 Save your configured software (configuration) and download this into your
TP170B panel.

- Inthe SIMATIC Manager, call the FB98.

- In order that when the control restarts, the axis selection of the TP170B
panel is at the permissible Axis_DB, in network 1, replace the 1 in L 1 by
the number of your first programmed Axis_DBs.

5 LAD/STL/FED - [FB9S -- "ET2005_FC_ORG" -- ET2005_FC_Shell\SIMATIC 300%CPU 315-2 DP'..\FE98]
{} File Edit Insert PLC Debug Wiew Options Window Help

D|2[3~E] & &[ml@| o] eild| [ 2sle] <! DIE &2 AH3H-

|C0ntents 0f: 'Environment’ Interface'
EI"@ Interface ;II |Name
o [

FESZ2 : Organisation ETzZ003% FC Drives

The indiwvidual ETZ00S5 FC driwes are called in this block.

In diesem Baustein werden die einzelnen ETZ003% FC Antriebe aufgerufen.

m: HMI Display, select drive after PLC startup

Conment -

ff=========s=s==s===cossssssssomoosssssssssssssssssssssssssssssssssssssssssssss
N "M 1o00.0v ff Brartup PLC 7
ZFE k_in ff no -= End

e e e e
L "ME 101"
L a
=T Af Driwve selected 7
SPE k_An FF owes —= End

o0 Save the FB98 and transfer it into the control.
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4

4.1

Controlling the ET200S FC using the
Axis_DB

You can take the control of the ET200S FC using the Axis_DB from the variable
table provided in the program example. The most important control and status
signals are listed in this variable table.

Control using the variable table

The most important control and status signals are listed using the variables table
supplied.

L] ¥ar - [ET2005 FC Drive 1 - ET2005_FC_Shell}SIMATIC 300%CPU 315-2 DP',57-Programm]
ﬁ Table Edit Imsert PLC Variable Wiew Options Window Help

| Dll@] @l #(mlelo]=| x| sl ef| Dlsl=] s ol

,‘; Address | Symbol | Displa| Status valu| Modify va

1 if Owerviewy of the most impartant contral and status sionals # Ubersicht der wichtisten Steuer- und Statussignale

2

3 1 Enakle TB170B Surface # Freigabesignal fir die TPA70B Oberflache

4 DE1DEX 21 “Sxis_DB_ET2005_FC_1" Basic_data Enable_HM|_surface BOOL -

5

& N Cortrol signals # Stewersignale

7 DE1DEY 7.0 “Axis_DB_ET2005_FC_1" Control_signals Control_word ON_OFF1 BOCL

g DE1DBEX 7.1 "Axis_DB_ET2005_FC_1".Control_signals Control_word OFF2 BOOL true
9 DE1.DEXY 7.2 "Axis_DB_ET2005_FC_1".Cortrol_signals Cortrol_word OFF3 BOOL true
10 DBE1DEX 7.3 "Axie DB_ET2005_FC_1".Control_signalzs Control_word Pulze_enable BOOL true
11 DE1.0EX 7.4 "Axis_DB_ET2005_FC_1".Cortrol_signals Control_word RFG_enable BOOL true
12 DE1.DEX 7.5 "Axis_DB_ET2005_FC_1".Cortrol_signals Control_word RFG_start BOOL true
13 DE1.DEX 76 "Axis_DB_ET2005_FC_1".Control_signals Control_word Setpoint_enable BOOL true
14 DE1.DEX 7.7 "Axis_DB_ET2005_FC_1".Control_signals Cortrol_word Fault_scknowledge BOOL

15 fi Frequency setpoint (-100 0 till +100,0%) # Frequenzsollvwert (Vorgabe in -100,0 bis +100,0%)

16 DB1.DEwW 5 E"Axis_DEl_ET2DDS_FC_1".Control_signals.Frequency_set ;DEC 500
17

158 I Status signals # Statussignale

19 DBE1 DEX 13.0:"Axis_DB_ET2005_FC_1"Status_signals Status_word Drive_ready BOOL
20 DBE1.0EX 132 "Axis_DB_ET2005_FC_1"Status_signals Status_word Drive_running BOOL
21 DE1.0EX 133 "Axis_DB_ET2005_FC_1" Status_signals Status_word Drive_fault_active BOOL
22 I dctual frequency (-100,0 1l +100 0% # Freguenzistwert (Anzeige in -100 0 bis +100.0%)

23 DB DEW 14 “Sxis_DB_ET2005_FC_1" Status_signals.Actual_frequency ‘DEC
24

25 N Faults # Fehlermeldungen

26 CB1DEW 18 “Axis_DB_ET200S_FC_1"Faults ET2005_FC_error_number CEC
27 DBE1.DEW 20 "Axis_DB_ET2005_FC_1"Faults Comm_error_resd DEC
28 DBE1.DEW 22 "Axis_DB_ET2005_FC_1"Faults Comm_errar_vwrite DEC
29 DE1.0BE 24 "Axis_DB_ET2005_FC_1"Faults Parameter_error_number DEC
30

31

Upper section (enable signal for the TP170B screen)

In order to control the ET200S FC drive from the TP170B screen, you must enable
the screen using bit 2.1 in the Axis_DB. After the screen has been enabled, then
the drive can only be operated from the TP170B screen.

o DBX 2.1 (Enable_HMI_surface)
- Signal 0, the ET200S FC is controlled via the PLC
- Signal 1, the ET200S FC is controlled via the TP170B

A&D SD
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Center section (control signals)

The most important control signals to the ET200S FC drive are listed in this area.
Please refer to the description of the Axis_DB for all additional signals.

o DBX7.1to7.6

- Signal 1 for all control bits switches the drive into the “Drive ready” state
(feedback signal via bit 13.0)

0o DBX 7.0 (ON_OFF1)
- Signal 0 stops the drive
- Signal 1 starts the drive

o DBX 7.7 (Fault_acknowledge)

- Asignal edge change from 0 to 1 acknowledges drive faults that may be
present

o DBW 8 (Frequency_set)

- Enters the frequency setpoint in the range from —100.0 to +100.0% (this
input refers to the reference frequency entered in parameter p2000).

Lower section (status signals)

The most important status signals to the ET200S FC drive are listed in this area.
Please refer to the description of the Axis_DB for all additional signals.

o DBX 13.0 (Drive_ready)
- Signal 0 = Control bits DBX 7.1 to 7.6 missing
- Signal 1 = drive ready to be powered-up

0o DBX 13.2 (Drive_running)
- Signal 0 = control bit DBX 7.0 is missing
- Signal 1 = drive running

o DBX 13.3 (Fault active)
- Signal 0 = no drive fault
- Signal 1 = drive faulted

o DBW 14 (Actual_frequency)

- Displays the actual frequency in the range from —100.0 to +100.0% (the
display refers to the reference frequency entered in parameter p2000).
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Lowest section (fault messages)

These fault messages are also displayed on the TP170B operator screen.

o DBW 18 (Drive faults)

- <> 0 =there is a drive fault, refer to ET200S FC List Manual, Chapter
Faults and alarms

o DBW 20 (Communications error when reading)

- <> 0 =there is a communications error when reading, refer to the ET200S
FC Operating Instructions, Chapter Connection to SIMATIC S7 > Error
messages via the user program.

o DBW 22 (Communications error when writing)

- <> 0 =there is a communications error when writing, refer to ET200S FC
Operating Instructions, Chapter Connection to SIMATIC S7 > Error
messages via the user program.

o DBB 24 (Parameter error r)

- <>0=there is a parameter error, refer to ET200S FC Operating
Instructions, Connection to SIMATIC S7 > Error messages via the user
program.

- Please note that you must subtract the value 1 from the displayed
number so that the number corresponds to the table in the Manual.

4.2 Control using the Axis_DB

The Axis_DB is sub-divided into 6 function blocks.

o 1% “Basic_data” block.

- The address of the ET200S FC, the start-up flag and the enable signal for
the operator interface are entered into the block (refer to Chapter 4.2
Adapting the program example to your HW Config and 4.3 Generating the
Axis_DB).

o 2" “Control_signals” block.

- Here, the control signals and the frequency setpoint are made available for
the ET200S FC drive (refer to Chapter 5.1 Control via the variable table).

o 3" “Status_signals” block (these can only be accessed, reading).

- Here, the status signals and the frequency actual value from the ET200S
FC drive are made available (refer to Chapter 5.1 Control via the variable
table).
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o 4" “Faults” block (these can only be accessed, reading).

- Active fault messages are output in this block. The fault messages are
displayed on the operator interface (screen).

- In addition, you are provided with a group fault signal (DBX16.3). This
signal is activated if a drive fault, a communications error or a parameter
error is signaled from the ET200S FC.

o 5™“HMI” block (these can only be accessed, reading).

- This block is used for internal communications to the TP170B panel. All
write access operations to this block must be made from FB99.

o 6" “Parameter” block (these can only be accessed, reading).

- This block is used for internal communications when reading and writing
parameters. All write access operations to this block must be made from
FB99.

For additional information about the Axis_DB, please refer to the appropriate
documentation.
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5

5.1

Description of the HMI operator screen

The operator screen for the ET200S FC is sub-divided into three function groups;
you can select these from the basic screen.

In order to protect against operator errors while the plant is operational, the screen
is inhibited by bit DBX2.1 (Enable_HMI_surface). You only have full access to the
operator screens if this bit has a 1 signal. When this bit has a 1 signal, then the
drive can only be operated from the operator screen.

General information about the operator screen:

(0]

A key indicator, located at the top left corner of all screens shows you the status
of the enable signal of the operator interface (DBX2.1, Enable_HMI_surface in
the Axis_DB).

- Ared indicator, operator screen is not enabled. The drive can be operated
via the PLC. All of the functions — with the exception of the diagnostics
screen — are inhibited.

A green indicator, operator screen released. The drive can be parameterized
and operated from the operator screen. Control The currently selected drive is
displayed in the upper area of the screens (exception, initial screen).

You have a Help button at the upper right hand corner of most of the screens.
You can use this button to call-up information about the active screen.

In order to provide a better overview, the input fields are white, and the output
fields are dark gray.

You have help texts available for various input and output fields. These can be
activated by clicking on the fields.

Most of the screens have a Diagnosis button. If the drive has a fault,
communications error or a parameter error, then this button starts to flash. The
diagnostics screen is selected when the button is pressed. The actual fault is
displayed in this diagnostics screen, and you are told where you can
acknowledge the fault.
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5.2 Initial screen

The following initial screen is displayed after selecting the ET200S FC operator
screen.

. Deutsch I Help I

Desktop

ET200S FC

Please select a drive

E

Diagnosis |

The red key indicator at the upper lefthand corner and the text Desktop is not
released or no drive is selected indicates that the DBX2.1 bit in the Axis_DB has
the signal 0. After this signal has been set and a drive selected, the individual
functions of the operator screen are displayed.

You can changeover the screen language to German using the Deutsch button.

Deutsch I Help |

Desktop

ET200S FC

Please select a drive

Operation Diagnosis Parameters

The individual functions of the operator screen are called-up by pressing the
following buttons — Operation, Diagnosis or Parameters.
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5.3 Operator Control

This screen is displayed after pressing the Operation button.

. Drive 1 Help I

You can operate the ET2005 FC drive using this screen Form.
Zaution, this Function is executed without any inkerlocks
from the remaining 57 program. This is the reason that you
should alwaws have an Emergency Stop button close ak hand.

|r|:u:u:|2 Drive: state =]

Diagnhosis

Using this screen, you can operate the drive selected in the initial screen.

It is important that you note that this control is independent of any interlocks
(permissive signals) implemented in your program. This is the reason that you must
always ensure that an Emergency Stop button is always located close to you. In an
emergency, you can press this button to stop the drive.

To operate the drive, proceed as follows.
o For Frequency set point enter a value between —100.0 and +100.0%.

o Now press the Set Releases button. The text Cancel Releases then is
displayed as feedback signals.

0 Then press the Start button. The drive moves as long as you press the button.

In the lower area, you can select selected monitoring parameters using a pull down
menu. These parameters are automatically read when calling the screen.

You can exit the screen by pressing the Back button.
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5.4

5.5

Diagnosis

This screen is displayed after pressing the Diagnosis button.

” Drive 1 Help I

Drive error (see List manual

FOOOZ Undervolkage

Parameter error (see Operating instructions)

Communication error ak reading {see Dperating instruckions)

Communication error ak writing (see Operating inskruckions)

ALK Back

Possible fault messages associated with the ET200S FC drive are displayed here.

For more detailed information regarding the fault messages, please refer to the
drive faults of the ET200S FC List Manual, Chapter Faults and alarms. For
parameter and communication errors, please refer to the ET200S FC Operating
Instructions, Chapter Connection to SIMATIC S7 > Error messages via the user
program.

You can acknowledge possibly queued fault messages using the ACK button.
You can exit the screen by pressing the Back button.

Parameters, quick commissioning

This screen is displayed after pressing the Parameter button in the initial screen.

Drive 1 Help I

Quick Commissioning...

v

Optimization...

v

MVIC - ROM...

Diagnosis Back
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You can carry-out a quick commissioning for the drive, selected in the initial
screen, by pressing the Quick commissioning... button.

. Drive 1 Help |

Fackory setting Parameters
Enktering »
parameters. ., Lozd
|
Brake » Maotar data Closed-loop
o identification. .. control data...
]
RAM -= ROM

—l Load

Diagnosis Back |

The individual steps for the quick commissioning are listed in the quick
commissioning screen. Please execute all of the steps in the specified sequence.

The function of the individual buttons will now be explained.

551 “Entering parameter” button

The parameter values saved in the CPU are displayed after pressing the
Entering parameters... button.

. Drive 1 Help I

1. Drive data set ;I
Europe [kWw], S50Hz v|

=

Asynchronous Makor
400

In this screen, you can modify the parameters in the CPU. After the Read button
has been pressed, the parameters are read-out of the selected ET200S FC and
saved in the CPU. In this case, the old parameter values in the CPU are
overwritten.

For more detailed information about the parameters, please refer to the ET200S
FC List Manual, Chapter Parameter description.

The remaining parameters required for the quick commissioning are displayed after
pressing the Page 2 button.
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* Drive 1 Help I

Wi {without sensor)
Mo main sekpoink LI

Back |

After you have entered all of the parameters corresponding to the motor data and
your particular application, then you can re-exit the screen using the Back button.

55.2 “Factory setting load” button
All of the parameters in the ET200S FC are reset to the factory setting after
pressing the Factory setting load button.
5.5.3 “Parameters load” button
The parameters previously modified using “Entering parameters...” are transferred
from the CPU into the ET200S FC after pressing the Parameters load button.
554 “Brake” button
' Drive 1 Help I
Brake disabled LI
0.0
0.0
Diagnosis Back
In this screen, you can activate and parameterize that the ET200S FC controls a
motor holding brake. For this particular function, you require a brake control
module. This module must be inserted to the right of the ET200S FC IPM25 power
unit.
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555

5.5.6

Initially, all of the parameter values, saved in the CPU, are displayed. Using the
Read button, the appropriate parameters are read-out of the ET200S FC and
saved in the CPU.

Using the Write button, you can transfer the displayed parameter values of the
motor holding brake from the CPU to the ET200S FC.

You can exit this screen by pressing the Back button.

“Motor data identification” button

| i | Drrive 1

The motor data identification run may only be
carried-out with the motor in the cold condition.

Warning:

The motor identification run may never be carried-out
when certain loads represent a danger {(e.q.
hanging,/suspended loads). Always secure loads before
starting the motor identification routine. When
the motor identification routine is started, the motor
shaft can move into its preferred position. This is
especially significant and noticeable for large motors.

Start motor data identification

Diagnosis

Before starting the motor identification routine, it is especially important that you
carefully read and understand the text displayed in this screen.

When the Start motor data identification button is pressed, then the motor
parameters are automatically calculated in two stages. The equivalent circuit
diagram data (p1910 = 1) is calculated in the first stage. In a second stage, the
magnetizing characteristic (p1910 = 3) is calculated.

Motor data identification active indicates that the motor data identification routine
is running. The display only changes back to Start motor data identification after
the motor data identification routine has been completed.

The Back button to exit the mask is inhibited when the motor data identification
routine is running.

“Closed-loop control data” button

This screen can only be selected if you activated, as control type VC without
encoder or VC with encoder for Entering parameters....

A&D SD

26/31



Copyright © Siemens AG 2010 All rights reserved

SI E M E NS Description of the HMI operator screen

Description of the “ET200S FC Shell” software package ET200S FC
| i | Drtive 1 |
YWarning:

While optimizing the controller, the drive is
accelerated, several times up to 50% of the rated
motor frequency.

The controller optimization run may not be started for
applications that do not permit this.

Start closed-loop control data

Diagnosis Back

Before starting the speed controller optimization runtime it is especially important
that you carefully read and understand the text displayed in this screen.

An automatic speed controller optimization routine (p1960 = 1) is started by
pressing the Start closed-loop control data button.

closed-loop control data active indicates that the speed controller optimization
routine is running. The display only changes back to Start closed-loop control
data after the optimization routine has been completed.

The Back button to exit the mask is inhibited when the motor data identification
routine is running.

5.5.7 “RAM -> ROM Load” button

To complete the quick commissioning, please press the RAM -> ROM Load button
so that the parameters in the ET200S FC are saved in a non-volatile fashion. This
procedure takes approx. 1 min.
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5.6 Parameters, optimization

This screen is displayed after pressing the Parameters button in the initial screen.

. Drive 1 Help I

Quick Commissioning...

v

Optimization...

v

MVIC - ROM...

Diagnosis Back

You can individually read and write parameters by pressing the Optimization...
button.

Caution!
Only the quick commissioning parameters are saved in the CPU. The parameters
that you change using the Optimization... screen are, in this application example,
only saved in the frequency converter and when a device is replaced, have to be
manually aligned or via an MMC.

5.7 Reading individual parameters

Drrive 1 Help |
Read parameter

‘Write parameker

Diagnosis Back
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In the upper area, you can read parameter values from the ET200S FC.

When the Read button is pressed, the parameters, selected using Parameter
number and Parameter index are read and displayed for Parameter value.

The parameter values are saved in various numerical formats (REAL or INT) in the
ET200S FC depending on the particular parameter. This is the reason that there
are two output fields for the parameter value (left = INT / right = REAL). More
detailed information is provided in the parameter description in the ET200S FC List
Manual.

Writing to individual parameters

In the lower area, you can change parameter values in the ET200S FC. However,
safety parameters cannot be changed. These can only be changed using the
Starter commissioning tool via the serial interface of the ET200S FC.

When the Write button is pressed, the parameters, selected using Parameter
number and Parameter index are overwritten with the value specified under
Parameter value.

The parameter values are saved in various numerical formats (REAL or INT) in the
ET200S FC depending on the particular parameter. This is the reason that there
are two output fields for the parameter value (left = INT / right = REAL). More
detailed information is provided in the parameter description in the ET200S FC List
Manual.

In order to permanently save the changes made to the parameters please press
the Start RAM -> ROM button. This procedure takes approx. 1 min.

You can exit the screen by pressing the Back button.
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5.8 Parameters, MMC <-> ROM

This screen is displayed after pressing the Parameter button in the initial screen.

. Drive 1 Help I

Quick Commissioning...

v

Optimization...

v

MYIC < -2 ROM...

Diagnosis I Back

When you press the MMC <-> ROM... button, you can overwrite the MMC inserted
in the ICU24 with the ET200S FC data or you can transfer the data in an MMC into
the ET200S FC.

. Dirive 1 Help

Diagnosis Back

When you press the Start ROM -> MMC button, data in the ET200S FC with the
number specified under MMC Filename is saved in the MMC. Subsequently, the
function Start MMC -> ROM s started automatically for data verification.

When you press the Start MMC -> ROM button, data in the MMC with the number
specified under MMC Filename is saved in the ROM memory of the ET200S FC.
After this download the control unit ICU24/ICU24F needs a power cycle for
initialization of its internal data.

You can exit the screen by pressing the Back button.
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6 Apendix

6.1 Internet link data

This list is in no way complete and only reflects a selection of suitable references.

Table 6-1

Subject area

Title

\1\

Siemens A&D Customer Support

\2\ Application note

Application sample for diagnosis and set up of
ET200S FC using the function block FB100

6.2 History
Table 6-2 History
Version Date Change
V1.0 February 2005 First edition
V11 January 2006 Document reviewed
V1.2 February 2006 HTML-page added, document reviewed
V1.3 August 2006 Document reviewed
V1.4 October 2006 Program added
V1.42 Januar 2010 Design up date
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